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Thank you for purchasing ACCUTRACE. We at AccuZIP Inc. want your experience with our products, services 
and customer support to be the best in the industry. Please send all correspondence regarding ACCUTRACE 
to support@accuzip.com  

It’s Simple! 

In a nutshell, you activate ACCUTRACE and process files as normal. Through the Activation Process, you will 
enter your Mailer ID and Serial Number Range. When you are ready to print labels or disk, simply check the 
“Print Barcode”, “Intelligent Mail” and “Upload to ACCUTRACE” boxes in the Print Settings window, then 
click Print or Continue to upload the tracking codes to our ACCUTRACE server.  
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ACCUTRACE Setup Procedures 

1. Activate ACCUTRACE using the Registration Serial Number and instructions provided in an emailed 
from activate@accuzip.com. 
- When you click the ‘Activate’ button in the Activate Product window, you will be prompted to enter 

a Mailer ID and Serial Number Range. You can find this information in email from 
noreply@accuzip.com. 

2. From the Additions Menu choose ACCUTRACE | Setup… 
 

 
- If you use our Licensed NCOALink®, the username and password information will already appear 

in their respective fields, otherwise check for an email from ncoalink@accuzip.com for this 
information. 

3. Copy the ‘Customer ID’ from the noreply@accuzip.com email and paste this 36-character ID into 
the ‘Customer ID’ box. 

4. Click ‘Test Connection’. A test file will be uploaded to the ACCUTRACE server so you can login and 
see it in your ACCUTRACE portal. If you see a “Testing was successful!” message in the ‘Connection 
Status:’ area, you are good to go and can click Save. 

5. Login to ACCUTRACE using your credentials from the email sent to you from noreply@accuzip.com. 
- The Job Summary List is updated automatically every 5-minutes, on the 5-minute mark, so you 

may have to wait up to five minutes to see the Test Job. 

IMPORTANT: Before you can begin using ACCUTRACE, please complete this Informed Visibility® Mail 
Tracking Data Delegation Request form and email it to iv@accuzip.com. We’ll send this to the USPS 
Informed Visibility Department, who will authorize scans from your Mailer ID to be pushed to 
ACCUTRACE. At that point, scanned IM Barcodes containing your Mailer ID should start appearing in 
ACCUTRACE.   

View the Featured Webinar on the AccuZIP6 MID Setup process.  
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You are ready to begin processing files and tracking 100% of your trackable mail, 100% of the 
time.  

 

Login or Click on JOB GUID Link 

Login to the ACCUTRACE portal Once logged in, you will see all of the jobs uploaded within the last year, 
ordered by the Date Mailed.  You can alternatively click on the Job GUID provided by the ACCUTRACE 
administrator for your account to securely view a particular job 

 

When you login to the ACCUTRACE portal, the most recent mailing will appear first. Select the mailing you 
would like to track by clicking anywhere on the row.  

 

 

 

 



 

Tracking Progress – It’s Simple!  

Once you drop the mail at the Post Office and they scan the first container or mail piece, ACCUTRACE comes 
to life so you can track 100% of your trackable mail in real-time. Your job results are available 24/7 and 
updated each hour. Job reports auto refresh every 60 seconds!  

 

Dashboard 
The Dashboard displays four (4) charts that update every 60-seconds with new scans (if applicable) for real-time 
tracking.  
 

The following reports are displayed on the Dashboard by default: 
1) In Home Delivery report 
2) Results by State report 
3) By First Scan report 
4) Out for Delivery report  

 

 

 
 



 

The Detail button at the bottom-left of each report can be used to see the Job Report Details and export the 
report to a CSV. Below are pictures and definitions of the interactive charts and maps you can select from the 
ACCUTRACE Dashboard. 

 

In Home Delivery Performance report: 

 
 

This report will show 100% of the USPS® scans that are categorized as Early, On Time, Late, En route or 
Returns, along with Not Scanned mail-pieces.   Scans that are considered Early, On Time or Late are based on 
the default 3 to 7 day delivery window that is set in the Job Start and Job End Date in your dashboard. You can 
modify the Job Start Date and Job End Date in the dashboard (if you have Administrative access) and the “In 
Home Delivery Performance” graphic will update accordingly. For instance, if you mailed your promotion on 
Monday (Job Mailed Date) for an event the following Monday (Job End Date), then any mail delivered after 
the following Monday would be considered “Late”.  

 
 
 
 
 
 
 
 
 
 
 
 
 



 

Results by State report: 

 
 
This report is a global view of all 50 states and the percentage of mail that has received at least one (1) scan. 
The lighter the shading of color, the fewer pieces in that state have received at least one scan.  Click on a State 
to see all of the Counties for that State. Click on a County to see a list of ZIP Codes within that County.  Click on 
a ZIP Code to see a list of mail-pieces within that ZIP Code and the final click on the mail piece will show you all 
of the USPS scans for the mail piece. 
 

First Scan report: 
 

 
This report charts all of the mail-pieces that received their initial scan. The initial scan will indicate that the 
mail is now in the hands of the USPS and is going to begin processing through the mail facilities on its way to 
the final destination.   

 



 

Out for Delivery: 

 
This report indicates the mail-pieces that are on the mail carriers’ truck, and scheduled for delivery.  This 
information is based on a final “physical” or “logical” scan from the USPS, that the mail was put on the mail 
carrier truck that day (final physical scan) or is about to be delivered (final logical scan). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 
 
 
 

Logical Delivery Events and Predicted Delivery reported on the Out for 
Delivery Reports  

 
 
ACCUTRACE has integrated USPS Logical Delivery Events and Predictive Delivery Data into the ACCUTRACE UI 
and Reports. The Logical Delivery Events and Predictive Delivery Events bars are located on the “Out for 
Delivery” Report and will soon be added to the “Results by First Scan Date” Report so that ACCUTRACE 
customer partners can see when mailpieces are predicted to be delivered from the very first scan. 
 
LOGICAL DELIVERY EVENTS: 
Definition: Leverages GPS tracking information from USPS carrier hand-held scanners to create logical delivery 
events. 
 
ACCUTRACE End-User Advantage: Gives insight into when your mail is delivered without the need for a 
physical scan. This helps fill in visibility gaps, giving you powerful end-to-end tracking capabilities. 
 
 
PREDICTIVE DELIVERY: 
Definition: USPS calculated date that predicts when the mail-piece is likely to go out for delivery based on 
historical and recent service performance data for that mail profile (mail class and shape) for that origin and 
destination pair. It will be calculated when the first manifest or scan is available to the USPS and updated with 
a revised prediction for each subsequent visibility event. 
 
ACCUTRACE End-User Advantage: USPS accumulated historical performance results build predictive delivery 
events which can become a great planning tool to aid meeting in-home delivery targets and be valuable in 
making adjustments to mail plans due to last minute changes to production schedules. Predictive Delivery 
Events are based on published service standards for the particular class and size of mail. 
 
These new data points give mailers unprecedented visibility into jobs and opportunities to better plan their 
mailings ahead of time and to coordinate other channels to arrive before the mail, as well as after it. 
 

 
 
 
 



 

 
Drill Down to the Piece Level and Map it! 

Free Google® Maps IM® Barcode Scan Locations  
Watch the mail piece as it travels across the United States to its final destination. ACCUTRACE plots all scan 
points from the BMEU drop to the Delivery Point of the Final Destination.  

After logging into your portal and selecting a job from the Job List Summary, the Job Detail window will 
display the “In Home Delivery Performance” report. 

 

1. Select “Results by State” from the “Job Reports” drop down. 
2. Click on one of the States that appear in a darker green color. You can also click on the Report icon to the left 

of the State abbreviation. 
3. The click-action will force ACCUTRACE to “drill-down” one level, from the State level to the 3-Digit ZIP Codes 

in the State. The 3-Digit ZIP Codes listed represent mail pieces in your mailing. 
4. Click on the Report icon next to the 3-Digit ZIP Code to drill down to the 5-Digit level. 
5. Click on the Report icon next to the 5-Digit ZIP Code to drill down to all of the mail-pieces that were mailed 

to the same 5-Digit ZIP Code. 
6. Click on the Report icon next to the mail-pieces delivery point barcode to see all of the IM Barcode Scans for 

that particular mail-piece. Here you can see all of the Scan Date & Time, District Name and ZIP Code of the 
facility that scanned the mail-piece, the type of equipment that scanned the mail-piece and if the mail-piece is 
out for delivery or not. If the Status is equal to 1, the mail-piece is out for delivery because the 1 represents a 
“Stop Scan” which is typically the last scan before the mail carrier receives the mail-piece. 

 
Notice that each time you clicked to “drill-down” a breadcrumb was placed above the view. This allows you to 
quickly go back to a previous drill-down quickly. 

 
7. Click on the 5-Digit ZIP code breadcrumb to see the mail-pieces again. 
8. Click on the Map icon to see all of the USPS® Scans and QR Code Scans plotted on a free Google Map®. 

 
Note: Green pins indicate USPS Scans while Yellow pins indicate QR Code scans. 

 
If the mail-piece contained a QR Code that was created by ACCUTRACE and the mail recipient scanned it, 
the QR Code Scan icon (located between the Report icon and Map icon) would eliminate Red. 

 

 



 

 

 
 
These are just a few of the reports in the powerful ACCUTRACE Mail Tracking and Reporting system. If you 
would like to learn more about these or other reports and capabilities of ACCUTRACE, please do not hesitate 
to contact us! www.accuzip.com/support

http://www.accuzip.com/support
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The ACCUTRACE QR Code (a.k.a. 2D Barcode) 

Generate “Piece Level” QR Codes easily with ACCUTRACE. Piece level QR Codes allow you to track the actual piece of 
mail or contact that was scanned. The scan triggers an immediate ping to your ACCUTRACE account so you have virtual 
real- time notification of 100% of each QR Code scan. Follow these steps to Create a “Piece Level” QR Code string and 
add this string to the AccuZIP6 5.0 database so you can print the QR Code in AccuZIP6 5.0 or Export the string to print 
the QR Code in other applications. 

 
1. Login to your ACCUTRACE portal. 
2. Click on the icon to the left of the job you want to create QR Codes for and the Job Detail view will appear. 
3. Select “Create Tracking URLs” from the Job Reports drop down. 
4. Enter the Default URL for the Website or YouTube®, or whatever default re-direct you want to use , e.g., 

http://www.accuzip.com 
- This is the default redirect for the QR Code. If the Tracking Codes file do not contain “Piece Level” Redirect 

URLs, then this URL will be used for the redirect. 
5. Check “Request Location” to create the QR Code string. 

- Request Location will prompt the mobile phone customer with a Allow/Don’t Allow message for their 
Geocode Location. 

- If Request Location is not checked, or if the mobile phone user presses “Don’t Allow” when prompted, 
ACCUTRACE will still return the Geocode location for their IP Address for an approximate QR Code 
location. 

6. Click Export and choose CSV from the popup that appears. 
7. A file named “export.csv” will be created. 

- If an export.csv file already exists, the new export.csv will be named “export (1).csv”, “export (2).csv”, etc… 
8. Choose an option below: 

http://www.accuzip.com/
http://www.accuzip.com/
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- Option A: The Tracking Codes were uploaded as a result of a Presort by clicking Labels from the Print Presort 
window: 

o Move the “export.csv” file to the Presort Folder and rename it to “presort.qrc”. * 
o From the Print Presort window click Print Labels 
o The QR Code String from ACCUTRACE is automatically added to the AccuZIP6 5.0 presorted 

database. You should see the new field named “userpcqr”. 
 

- Option B: The Tracking Codes were uploaded by choosing File | Print Labels. 

o Move the “export.csv” file to the original database folder and rename it to “databasename.qrc”. * 
▪ Note: “databasename.qrc” should be changed to the exact name of your database name, 

just use “.qrc” as the extension. 

o From the File Menu, choose Print | Labels 
o The QR Code String from ACCUTRACE is automatically added to the AccuZIP6 5.0 presorted 

database. You should see the new field named “userpcqr”. 
 

*For those who have file extensions hidden (Tools menu > Folder Options > Hide Extensions > View tab > Hide 
Extensions for Known File Types) , I’ve found that when someone tries to rename export.csv to databasename.qrc or 
presort.qrc, they don’t end up changing the extension of the file, because the extension isn’t displayed. Therefore, the 
change causes the file to be named presort.qrc.csv, leaving it as a .qrc file, and not having the populated userpcqr field 
added to the file. 

 
You can now Print the QR Code with AccuZIP6 5.0 or Export the QR Code String and use it with other applications that 
have a QR Code Encoder and Font. 
 
 

Print the QR Code with AccuZIP6 5.0 
AccuZIP6 5.0 can create a static or variable QR Code image and print it on a Report or Label. 

 
1. Before you can Print the QR Code with AccuZIP6 5.0, you must create and merge the QR Code with the AccuZIP6 

5.0 database or presort by following the Steps (above). 
2. Choose an option below to open the Print Settings window: 

- Option A: From the Print Presort window click Labels 
- Option B: From the File menu, choose Print |Labels 

3. Select “Label Format” from the Output drop down 
4. Select “5164 with QR Code.lbx” from the Template drop down 
5. Click Print 

 
You can Edit this template and copy the QR Code box and paste the box into any Label or Report Template to print the 
QR Code using the data in the “userpcqr” field. If you have another field in the AccuZIP6 5.0 database that you want to 
print the QR Code from, double-click on the QR Code box and change “userpcqr” to the field name you want to 
generate the QR Code from. 
 

Always verify the QR Code before printing all of your mail pieces using a 

SmartPhone or QR Code Scanner.
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Piece Level URL Redirects 

This unique and powerful feature gives you the ultimate control for what the mail recipient sees on their 
mobile phone when they scan the ACCUTRACE QR Code. 

 
Each mail piece in ACCUTRACE can have its own redirect URL!! All of the redirects are handled by 
ACCUTRACE. The redirect information is NOT in the printed ACCUTRACE QR Code. This allows you to change 
the redirect at any time, even after the mailing has been printed and dropped at the post office. 

 

If you want to use the same URL redirect for the entire mailing, then you can ignore this section. Instead, after 
the job is uploaded, you can enter the Job Default Redirect URL from the Job Detail view in the ACCUTRACE 
Portal by selecting the “Create Tracking URLs” from the Job Reports drop down. Enter the job level redirect in 
the URL: text box. This URL is used anytime the “Piece Redirect URL” column is empty for a given mail piece. 

 

Setup… 
1. From the Edit menu, choose Fields… 
2. Insert a new field and name it “USERPCURL”. Set the field type to Character with a width up to 254, or 

set the field type to Memo for longer URL’s. 

3. Enter a URL specific to the mail recipient into the USERPCURL, e.g., http://www.accuzip.com 
 

Scenarios 
- Real Estate Agents - Each mail piece could have a specific redirect to a specific Real Estate Agent 
- Pizza Restaurant – Each mail piece could have a specific redirect to the closest Pizza Restaurant to 

the mail recipient’s mailing address. 
- Discount Coupon – Each mail piece could have a specific redirect for a varying discount based on 

the distance from the mailing address and the store location. 
- YouTube® video – Each mail piece could have a specific redirect to a certain YouTube video based 

on the industry type. 
- Customer Relationship Management – Each mail piece could have a specific redirect based on if 

they are a current or potential customer. 
 
Setup “Alerts” from the ACCUTRACE Portal in the Job Detail view. Alerts can be immediate upon an IM 
Barcode or QR Code scan, or setup to alert every hour or once a day. 

http://www.accuzip.com/
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Piece Level Email and Texting 

This unique and powerful feature gives the mailer the ultimate control on who receives the email or text alert 
notifications when an IM Barcode is scanned by the USPS® or ACCUTRACE QR Code is scanned with a mobile 
phone. 

 
Each mail piece in ACCUTRACE can have a unique email and/or text phone number to whom will receive 
the alert notifications. 

 

If you want to use the same Email and/or Text phone number for the entire mailing, then you can ignore this 
section. Instead, after the job is uploaded, you can enter the Job Email(s) from the Job Detail view in the 
ACCUTRACE Portal. Enter the job level Email and/or Text numbers, separated by a comma in the Job 
Email(s): text box. This information is used anytime the “Piece Email and/or Text” column is empty for a 
given mail piece. 

 
Setup… 

1. From the Edit menu, choose Fields… 
2. Insert a new field and name it “USERPCTXT”. Set the field type to Character with a width up to 254, or 

set the field type to Memo for longer email and text phone number strings. 
3. Enter Email addresses and/or Text phone numbers separated by a semicolon specific to the mail 

recipient into the USERPCTXT, e.g., noreply@accuzip.com; 8059999999@txt.att.net 
 

Now each time an IM Barcode is scanned and/or a QR Code is scanned by a smart phone, an Alert message 

can be sent via email and/or text message immediately! 

mailto:noreply@accuzip.com
mailto:8059999999@txt.att.net
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Piece Level User ID 

This unique and powerful feature provides the mailer with the ultimate visibility when an IM Barcode is 
scanned by the USPS® or ACCUTRACE QR Code is scanned with a mobile phone. 

 
Each mail piece in ACCUTRACE can have a unique User ID that can be used to identify the mail recipient to 
the mailer when an IM Barcode is scanned by the USPS® or ACCUTRACE QR Code is scanned with a mobile 
phone. The User ID field can contain information such as the mail recipients name and phone, or mailers 
piece ID or whatever value you want to identify the mail piece when it is scanned and the Alert is received. 

 

If the User ID field contained the mail recipients name and phone for example, the Alert email or text message 
that was sent to the mailer or the piece level Email or Text phone would contain same User ID information 
that could be used to immediately contact the mail recipient. This is an extremely powerful and proactive 
ACCUTRACE feature that gives the mailer the ultimate tool for communicating with the mail recipient at the 
time the mail recipient is actually handling the mail piece. 

 
Setup… 

1. From the Edit menu, choose Fields… 
2. Insert a new field and name it “USERPCID”. Set the field type to Character with a width up to 50. 
3. Enter the mail piece specific into the USERPCID, e.g., Contact Name | Phone 
4. DO NOT USE COMMAS IN THIS FIELD. We recommend using a pipe or space between values. 

 
Now each time an IM Barcode is scanned and/or a QR Code is scanned by a smart phone, an Alert message 

containing the User ID information can be sent via email and/or text message immediately! 
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Branding your Portal with your Logo 

 

Follow the simple steps below to upload your logo to ACCUTRACE. The logo will print on all reports generated 
by ACCUTRACE. 

 
1. After you login to your ACCUTRACE portal, click on Settings. 
2. After you login to your ACCUTRACE portal, click on Settings. 
3. In the Logo for Branded Site area, click on the Open Folder icon. 

 

Note: The recommended maximum size for your logo is 950 x 75 pixels. Any image format (gif, jpg, bmp, png, 
etc) is acceptable. 
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Tracking Usage 

The ACCUTRACE 45-Day Tracking Codes Usage Bar. 
 

 

 

Hover your mouse over the 45-Day Tracking Codes bar to show the total number of records that received 
their first scan in the past 45-Days (Usage) and the serial range you purchased (Limit). 
 

When you click on the bar, the jobs used in the calculation are downloaded to a file 
named Limit_and_Usage_report_*.zip so you can see which jobs are being tallied over the last 45-Days. 
 

If your usage exceeds your limit, you will see this message when you log into your portal: 
 

 

 

Example: You have purchased an ACCUTRACE subscription with 200,000 credits, but within the last 45-Days you 
have 300,000 scanned records in the jobs you’ve uploaded. Jobs that included record 200,001 and all other 
records that exceeded the limit will appear in the Limit and Usage Report. 

 

  

  

ACCUTRACE customer agrees to use only the range and/or amount of unique serial numbers issued to the 
account. This number is reflected in the "Total Unique Serial Numbers" section on the ACCUTRACE order form. 
At any time, if customer utilizes serial numbers outside of the issued Low or High range or beyond the amount 
purchased in a 45-day period, customer agrees to pay additional Licensing Fees at the same minimum price. 
Accounts that are in excess of their allotted and agreed upon account limits will automatically be upgraded to 
the ACCUTRACE Tier that matches the 45-Day Actual Average and Annual Usage. 

ACCUTRACE is a Trademark of AccuZIP, Inc. This Cloud based solution is made in the United States of America. 
We want your organization to be proud of this solution. Your comments are important. Please send all 
correspondence to support@accuzip.com. 

mailto:support@accuzip.com

